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Preface
Building Energy Simulation: A Workbook Using DesignBuilder is an outcome of a series of
training programs conducted for participants with varied backgrounds. The authors experi-
mented with various teaching techniques and arrived at the conclusion that the most effective
method of imparting these training programs is through tutorials and step-by-step instruc-
tions along with graphical illustrations. This book is an updation of its first edition, released
in 2017. Several new tutorials have been added, as was suggested to the authors through feed-
back received from book users across the world. The authors thankfully acknowledge these
inputs.

The simulations in this workbook are performed using the DesignBuilder software for
illustration purpose to help explain the aspects of a whole-building energy simulation pro-
cess. This workbook adopts the ‘learning by doing’ principle to explain the fundamentals of
building physics and building services and, in turn, help readers understand the concept of
building energy performance. Based on participant feedback during the training programs,
the authors decided to use EnergyPlus with DesignBuilder as the front end to explain the
simulation process.

The book has been organized as follows:

• The first 11 chapters of this workbook cover various aspects of simulation, such as
creating the building geometry, assigning material and equipment and analysing the
results.

• Chapter 12 is new in this edition and explains the method of simulating renewable-
energy systems fitted on buildings.

• Chapter 13 is also a new one that explains the method of carrying out life-cycle
cost analysis of various design options, including sensitivity and uncertainty
analysis.

• Chapter 14 explains simulation for the whole-building performance method of the
ASHRAE 90.1 standard.

• Chapters 15 through 17, which are available online, provide exercises to simulate
three different building projects.

The authors would highly appreciate any feedback or suggestions for further improving this
workbook.
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1 Getting Started with Energy
Simulation

This chapter is designed to acquaint you with building energy simulation. It starts with the
introduction of various components and requirements for simulation and then gradually
progresses to the concept of simulation using a ready example file. It establishes the impact
of key simulation inputs such as lighting power density (LPD), activity, setpoint, window-to
-wall ratio (WWR), orientation and fresh air intake on energy consumption. There are 11
tutorials to help you navigate through the chapter. By the end of this chapter, you will be
familiar with key input parameters, output visualization and the overall simulation process.

BUILDING ENERGY SIMULATION

Building energy simulation is performed using a computer to virtually represent a building
design and perform physics-based calculations. The simulations can range from a building
component to a cluster of buildings. For energy simulation, the building model, the usage
pattern and the weather of the location are required to determine various outputs, such as
peak loads, system sizing and energy consumption for any given period. This information
can be used for estimating the utility bills and for evaluating cost-benefit analyses of various
design strategies.

Some of the uses for energy simulation tools include the following:

Early design decisions. In the early design stage, decisions such as the orientation and
layout of the building are taken. Energy simulation can help in evaluating various
design strategies. However, a detailed simulation may not be possible because of the
limited information available at this stage.

Component or material selection. Simulation helps in the decision-making process when
selecting individual components of the building envelope or systems. It is quite com-
monly used to carry out cost-benefit analyses of various designs and components.
Therefore, modelling at this stage needs to be performed with greater accuracy than
the modelling for early design decisions.

Retrofitting decisions. For retrofits of existing buildings, energy simulation can help in
selecting cost-effective solutions. For an accurate analysis, the simulation model
should be calibrated using the measured performance data of the building.

WHAT IS NEEDED FOR ENERGY SIMULATION

Energy simulation of buildings can be performed using a systematic approach. A lot of
data is required. It is recommended that you collect the required data before you start the
modelling. The following basic information is required:

Location and weather file. Energy simulation tools need hourly data on ambient condi-
tions (i.e. temperature, humidity, wind velocity, solar radiation, etc.) at the building
location. This information is available in weather files. Simulation tools use these
weather files to extract the hourly ambient conditions while carrying out the

1



simulation. However, for some locations, the weather file may not be available. In
such cases, the weather file of some other location with similar weather conditions
can be used. In addition, weather files are available in different formats. Different
simulation tools use different formats of weather files. Utilities are available on the
web for converting a weather file from one format to another.

Building geometry. Building elevation and floor plans are required to create the geo-
metric model of a building. Architectural drawings may have many details that
might not be directly useful for energy simulation. It is useful to simplify the draw-
ings based on thermal zoning into a single line drawing by removing unnecessary
details.

Envelope components. It is necessary to have construction details, such as the thickness
and thermophysical properties of materials used in each layer of the building enve-
lope. Besides the opaque components, it is very important to know the properties of
the window glass, frames and shading devices.

Building services. Information on various services such as heating, ventilation and air
conditioning (HVAC) and lighting is required. This includes equipment capacities,
energy efficiency, location and controls.

Use of the building. The hourly values of the following are required:

• Occupancy
• Lighting
• Equipment
• Thermostat setpoint
• HVAC operation

HOW SIMULATION SOFTWARE WORKS

The simulation program enables simultaneous interaction of the geometric model with outdoor
conditions, occupancy and use of building systems to predict various loads arising in the build-
ing on an hourly basis. Basic laws of physics and energy balance equations are used for calcula-
tions. The energy consumption for the operation of systems corresponding to the heat and
other loads is also calculated on the same time scale. Results of the processing are passed to the
calculations of the next time slice and are also supplied to the output file. This process con-
tinues for the entire duration of the simulation, and the final output is seen as aggregated or on
the same time slice for which calculations have been carried out. Most simulation tools are cap-
able of simulating the energy flows through different building components on an hourly basis,
including the transient effects of the envelope and systems.

The advantage of energy simulation over the classical method is that various effects
of the thermophysical properties of the materials and the performance of the various
systems under varying external and internal environmental conditions are considered
in energy calculations. Most energy simulation tools do not require any special comput-
ing power because they can be run on commercially available desktop computers or
laptops.

This chapter provides basic tutorials on creating simple geometry and analysing the
impact of building orientation, WWR, internal loads and fresh air delivery, with a special
focus on analysing building energy performance and system sizing. The tutorials are fol-
lowed by exercises. There are many energy simulation tools available. For this book, we will
be using DesignBuilder v6.1. The latest version of DesignBuilder can be downloaded from
https://designbuilder.co.uk/download. Please note that there can be minor differences in the
user interface and simulation results between the latest version of DesignBuilder and the
version used for this book.

2 Building Energy Simulation
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Tutorial 1.1

Opening and Simulating an
Example File

GOAL

To evaluate the energy performance of a building model provided in an example file with
DesignBuilder installation

WHAT ARE YOU GOING TO LEARN?

• How to simulate an example file
• How to view energy consumption results based on utility type or fuel, such as elec-

tricity or gas
• How to view the end-use energy consumption (i.e. lighting, equipment, fan, cool-

ing, heating, pump and domestic hot water)
• How to view results on a daily, monthly and annual basis
• How to switch between metric (Système international [SI]) and English (inch-pound

[IP]) measurement units
• How to calculate energy use intensity (EUI)

PROBLEM STATEMENT

In this tutorial, you are going to simulate an existing template, Courtyard with VAV
Example, from the DesignBuilder library and simulate it for the climate of London. You
will learn how to view the daily, monthly and annual energy consumptions in a graphical
format. You will also learn how to view the annual fuel breakdown and fuel total.

3



SOLUTION

Step 1: Start DesignBuilder. The DesignBuilder main screen appears.
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Step 2: Double-click Courtyard with VAV Example in the DesignBuilder templates under
the Recent Files tab. A New project screen appears.

Courtyard with VAV Example is a DesignBuilder template file. A DesignBuilder tem-
plate file helps to provide examples of various building typologies and systems such
as geometry, HVAC system and passive strategies. Relevant data from the example
files can be exported and imported into other DesignBuilder models.

Step 3: Click CA-SAN FRANCISCO INTL. Three dots (. . .) appear.

If you have installed DesignBuilder for the first time on your system, CA-SAN FRAN-
CISCO INTL may appear as your location. If you have used DesignBuilder previ-
ously, you may get some other location based on your previous settings.
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Step 4: Click the three dots (. . .). The Select the location template screen appears.

Step 5: Select LONDON/GATWICK ARPT. Click OK. The Select location for template-
based new file screen appears.

LONDON/GATWICK ARPT is a weather file that comes along with the Design-
Builder installation. For all other locations, an internet connection is needed to down-
load the weather files.
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Step 6: Click OK.

The building layout appears with the following tabs at the bottom of the central display screen:

• Edit
• Visualise
• Heating design
• Cooling design
• Simulation
• CFD
• Daylighting
• Cost and carbon

Getting Started with Energy Simulation 7



Step 7: Select the Simulation screen tab. Click Update data.

The Edit Calculation Options screen appears.

8 Building Energy Simulation



Step 8: Enter the Simulation Period start date as 1 Jan and the end date as 31 Dec. Click
OK to start the simulation.

A screen appears showing the simulation progress. Depending on the configuration of the
computer, it can take several minutes to complete the simulation.

After the simulation is completed, results are displayed in the Analysis subtab of the Simu-
lation Screen tab.

Step 9: Under Display Options, select Fuel totals from the Data drop-down list and Run
period from the Interval drop-down list. A screen appears with a bar graph for annual fuel
totals for electricity and gas.

Note: The results are either displayed in IP or SI units based on your configuration of
DesignBuilder. Switching between SI and IP units is explained in Step 15.

Getting Started with Energy Simulation 9
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Step 10: Select the Normalise by floor area check box and All floor area from the By drop-
down list to view the energy use intensity (EUI) of the building.
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Units for the Fuel totals can be seen on the y-axis of the graph.

The term energy use intensity (EUI) refers to the energy consumption of the building
per unit area per annum. The same term, in some countries, is also called the energy
performance index (EPI). The EUI of a building is calculated by dividing the annual
total energy consumption (all fuel types) of the building by its gross floor area. The
unit of measurement is kWh/m2 yr or kWh/ft2 yr or Btu/ft2 yr. A lower EUI means
a better energy performance.

The gross floor area of a building is the total built-up area, which includes all condi-
tioned and unconditioned enclosed spaces of the building.

12 Building Energy Simulation



Step 11: Change the Interval from Run period toMonthly to view monthly results. Refer to Step 9.
A DesignBuilder message box appears. Click Yes. Click Update Data. Click OK to per-

form a simulation to update the results.
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Step 12: Select Grid from the Show as drop-down list to view results in a grid format.

Step 13: Select Fuel breakdown from the Data drop-down list to view results for fuel breakdown.
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In all the preceding steps, the results are in SI or IP units based on the existing configur-
ation of DesignBuilder in your system. To change the units, perform the following steps.

Step 14: From the Tools menu, select Program options. The Edit Program Options screen appears.

Getting Started with Energy Simulation 15



Step 15: Select the International tab, and select Units as per your requirement. Click OK.
DesignBuilder updates all the values in the selected units. SI units will be used in this
workbook.

Step 16: From the File menu, select Save to save this model.

EXERCISE 1.1 COMPARE THE EUIS OF RESIDENTIAL AND OFFICE BUILDINGS

Courtyard with VAV Example is for an office space. Simulate a file with residential usage
and compare the results.

DesignBuilder can open only one file at a time.

Hint: Open the file House example 1. Ensure that the location is London Gatwick. Repeat the
steps given in Tutorial 1.1 to find the EUI. Enter the EUI values in the last column of Table 1.1.

You can see that even with the same location, the EUIs of office buildings and residential build-
ings are different. This is mainly due to the difference in building usage, which includes difference
in timing and duration of use, occupancy density, nature of equipment used and other factors.
Office buildings usually have a higher EUI, as they have higher internal loads (see Table 1.1).

TABLE 1.1
Energy use intensities for office and residential buildings

Energy use

EUI (kWh/m2)

Office building Residential building

Electricity
Gas
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Tutorial 1.2

Creating a Single-Zone Model

GOAL

To create a single-zone model and find heating and cooling capacities

WHAT ARE YOU GOING TO LEARN?

• how to draw, view and render a building model
• How to size runs for heating and cooling capacities
• How to perform an annual energy simulation

PROBLEM STATEMENT

Create a new file and draw a 40- × 20-m rectangular building of height 3.5 m with location
as LONDON/GATWICK ARPT. Perform a cooling and heating sizing and annual energy
simulation.

SOLUTION

Step 1: Click File and select New file. The New file screen appears.
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Step 2: Enter First Building in the Title text box and click OK. A blank building layout appears

Step 3: Select Plan from the View rotation drop-down list.

In the DesignBuilder display, the red line represents the x-axis, the green line the
y-axis and the blue line the z-axis.
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Step 4: Click the Add new building button. The Add new building screen appears.

Step 5: Click OK. The screen appears with a cursor to draw a building.
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Step 6: Move the pointer to the Origin. Left-click, and move on the positive x-axis. The
length of the segment is shown. (In case of any mistake, you can choose to cancel the
drawn line by pressing the ESC key and then try again.)
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Step 7: Type 40. You can type directly, and the text box for length will be highlighted. Fill
in the value for the length in the Drawing Options section. The Length of the wall is set to
40 m. Ensure that the properties under the Geometry section are as follows:

• Block type: Building Block
• Form: Extruded
• Height: 3.5 m

Press Enter.
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Step 8: Scroll the mouse wheel to zoom in or zoom out until you can see the complete line
of 40 m in length. Move the pointer parallel to the positive y-axis. It snaps when a dashed
vertical line appears. Type 20 to draw the second side of the rectangle. Press Enter.

Step 9: Similarly draw other segments and complete the rectangular building block of
dimensions 40 × 20 m. The following screen shows the completed block.
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Step 10: Select the Dynamic orbit tab on the main menu bar. This shows the block in the
orbit mode. Click and drag the mouse in the layout to view the block in the orbit mode.

DesignBuilder Snap

When drawing perimeter lines, block partition or surface opening direction snaps can
be used to draw lines

• Parallel with the active drawing plane axes (axis snap),
• Parallel with existing elements (parallel snap) or
• Perpendicular to existing elements (normal snap).

Source: https://designbuilder.co.uk/helpv6.0/Content/Direction_snaps1.htm.

Now you will learn to run the system sizing.

Getting Started with Energy Simulation 23
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Step 11: Select the Heating design screen tab at the bottom. Click Update data. The Edit
Calculation Options screen appears.

Heating design calculations show the heating system size in the worst conditions (no
internal loads and solar heat gains) for a winter design day. Steady-state simulations
assume that the temperature across the envelope does not vary with time.

Step 12: Select OK. The screen appears with the average and total winter steady-state
design data for the current building in graphical format.
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The graph in the preceding figure shows the heat balance to maintain an inside tempera-
ture of 22°C when the outdoor dry bulb temperature is −4.4°C. You can see that there is
a heat flow from the inside to the outside (shown as negative numbers; the convention is
that a positive value is used for a heat flow from the outside to the inside) through the
envelope as a result of infiltration and ventilation. To balance this heat loss, the required
zone sensible heating is 58.36 kW. The table in the preceding figure also shows the air tem-
perature, radiant temperature and operative temperature, where the operative temperature
is calculated as the average of the radiant and air temperatures.

Steady-state heat loss is the total heat loss from the building. In other words, it is the
amount of heat needed to maintain the given indoor comfort temperature.

Step 13: Select the Summary tab. The heating design data summary appears.

Design capacity is the total heat loss multiplied by the sizing factor. Sizing factor is
the safety factor considered in sizing an HVAC system. For example, heating systems
are commonly oversized by 25%.
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The design capacity of the building is 72.950 kW, which is calculated considering the
sizing factor of 25% over the steady-state heat loss of 58.36 kW. The design capacity nor-
malized by area is 95.55 W/m2, which is calculated for the building floor area. In this case,
the building dimensions are 40 × 20 m, and the building area is 800 m2 (net floor area is
765.24 m2).

Step 14: Similarly select the Cooling design screen tab at the bottom. Click on Update data.
The Calculation Options – Building 1 screen appears. Click OK. The temperature, heat gains
and other parameters appear in graphical format.

A cooling system is commonly oversized by 15%.
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Step 15: Select the Summary tab. The screen appears with the cooling design data summary.

The screen data are provided in tabular format in Table 1.2. The load calculated in the
building is 79.36 kW. The cooling load is also described in tons of refrigeration (TR). For
this building, it is 22.6 TR. Enter the cooling and heating capacities in Table 1.4.

TABLE 1.2
Data for the single-zone model

Zone Block 1: Zone 1

Design capacity (kW) 79.36

Design flow rate (m3/s) 4.76

Total cooling load (kW) 69.01

Sensible (kW) 59.73

Latent (kW) 9.28

Air temperature (°C) 24.0

Humidity (%) 49.7

Time of max cooling August 15:00

Maximum operating temperature in day (°C) 29.5

(Continued )
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A ton of refrigeration (TR) describes the heat-extraction capacity of refrigeration and
air-conditioning equipment. It is defined as the rate of heat transfer that results in the
melting of 1 short ton (907 kg) of pure ice at 0°C in 24 hours. A refrigeration ton is
approximately equivalent to 3.5 kW of cooling effect.

Sensible vs. Latent Heat

Sensible heat is the energy required to change the temperature of a substance with no
phase change. Sensible heat represents only the dry bulb temperature change. Latent
heat, however, does not affect the temperature of a substance. Heat that causes
a change of state with no change in temperature is called latent heat. A cooling
system should be capable of removing both the sensible and latent heats from
a building. Therefore, the total cooling capacity of a system will be (sensible heat load
+ latent heat load) × sizing factor.
In this tutorial, sensible heat is 59.73 kW and latent heat is 9.28 kW. The sum of

both sensible and latent heats is 69.01. Therefore, the design capacity calculated by
multiplying 69.01 by the sizing factor (1.15) is 79.36. You can divide this by 3.51 to
convert it into the unit of tons of refrigeration: 79:36

3:51 ¼ 22:6TR

TABLE 1.2 (Cont.)

Zone Block 1: Zone 1

Floor area (m2) 765.3

Volume (m3) 2,678.3

Flow/floor area [litres (l)/s-m2] 6.22

Design cooling load per floor area (W/m2) 103.7

Outside dry bulb temperature at time of peak cooling load (°C) 30.5
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Step 16: Select the Simulation screen tab to perform the annual simulation. Select Fuel
breakdown from the Data drop-down list, Run period from the Interval drop-down list and
Grid from the Show as drop-down list.
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Step 17: Select the Normalise by floor area checkbox and All floor area from the By drop-
down list to view the EUI of the building. Also select Fuel totals from the Data drop-down
list. The DesignBuilder message screen appears. Click Yes to perform simulations for all
floor area. Enter the electricity EUI value in Table 1.3.

Step 18: Save the model as First Building on your desktop. You are going to use this model
in forthcoming tutorials.
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EXERCISE 1.2

Compare the EUI of a large building with that of a small building. Repeat the tutorial to
create an 80- × 40-m rectangular building. Compare the EUI of the larger building with that
of the smaller building (the 40- × 20-m building created in Tutorial 1.2), and enter the result
in Table 1.3. Enter and compare the cooling and heating capacities of the larger building in
Table 1.4. The method to calculate the EUI (kWh/m2 yr) is explained in Tutorial 1.1.

The following observations can be made as a result of Exercise 1.2:

1. The EUIs of both the buildings are different.

2. The cooling and heating equipment capacities are greater for the 80- × 40-m build-
ing than for the 40- × 20-m building. Larger buildings require higher-capacity
equipment because of their greater envelope area, occupancy and internal loads.

3. Cooling/heating equipment capacities per unit area are also different. A large build-
ing has a lower capacity per unit area. The main reason behind such a difference is
that although most of the internal loads, such as occupancy, lighting and equip-
ment, vary linearly with area, the heat gain/loss through the building envelope does
not follow the same trend because of the nonlinear variation in the exposed surface
area versus the floor or carpet area.

TABLE 1.4
Cooling and heating capacity for a large and small building

Capacity Building with 40- × 20-m dimensions Building with 80- × 40- m dimensions

Cooling equipment (kW)

Heating equipment (kW)

Cooling per unit area (kW/m2)

Heating per unit area (kW/m2)

TABLE 1.3
EUI for a large and small building

Energy use

EUI (kWh/m2 year)

Building with 40- × 20-m dimensions Building with 80- × 4-m dimensions

Electricity

Gas
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Tutorial 1.3

Evaluating the Impact of Building
Location and Orientation

GOAL

To evaluate the impact of building location and orientation on HVAC system sizing and
building annual energy consumption

WHAT ARE YOU GOING TO LEARN?

• How to change the location of a building
• How to download a weather file
• How to change the orientation of a building
• How to analyse the impact of weather and orientation on a building’s performance

PROBLEM STATEMENTS

1. In Tutorial 1.2, a 40- × 20-m rectangular building was simulated for London.
Simulate the same building model for New Delhi/Palam, and compare the HVAC
sizing, monthly energy consumption and annual energy consumption.

2. Rotate the building 90 degrees clockwise, and simulate it for New Delhi. Compare
the results of the two models (without rotation and with 90 degrees of rotation).
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SOLUTION

Step 1: Open the model saved in Tutorial 1.2.

Step 2: Click First Building.
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Step 3: Select the Location tab. The Location Template screen appears.

Step 4: Click LONDON/GATWICK ARPT. Three dots (. . .) appear. Click the three dots.
The Select the location template screen appears.
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Step 5: Scroll to select INDIA. Double-click INDIA, and select NEW DELHI/PALAM.
Click OK.
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Step 6: Click Building 1.
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Step 7: Select the Simulation tab. Click on Update data. The Edit Calculation Options screen
appears. Click OK. If your computer is connected to the internet, DesignBuilder directly
downloads the weather file. If, for some reason, DesignBuilder is not able to download the
weather file, you can manually download the weather file from https://energyplus.net/weather.

Place the downloaded weather file in the folder C:\ProgramData\DesignBuilder\Weather Data

DesignBuilder uses hourly weather files with the .epw extension. Weather files can be
downloaded from the following link: https://energyplus.net/weather. Weather files that
are downloaded directly from the website should be copied in the DesignBuilder wea-
ther data folder located at C:\ProgramData\DesignBuilder\Weather Data.
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Step 8: Compare the simulation results for the London and New Delhi locations. Results
for the London location can be obtained from Tutorial 1.2.

The impact of location on building energy consumption can be seen from the results
reported in Table 1.5. You can see that there is no change in room electricity and lighting.
This is because there were no change in internal loads; further, as there is no daylight-based
control, the change in location does not change these values. From the results in Tables 1.5
and 1.6, the following observations can be made:

• The heating energy consumption is more in London than in New Delhi. This is
because London has a colder climate than New Delhi.

• The reverse is true for the cooling energy consumption because New Delhi is
warmer than London in summer.

• Similarly, there is a significant effect of location on the cooling and heating equipment
capacities.

The following steps show how to change the orientation.

TABLE 1.5
Energy consumption with a change in building location

Type of consumption

Annual fuel breakdown data (kWh)

London (kWh) New Delhi (kWh)

Room electricity 33,167.88 33,167.88

Lighting 47,934.77 47,934.77

Heating (gas) 30,669.47 1516.51

Cooling 14,385.49 102,428.10

Domestic hot water (DHW, electricity) 3,001.15 3,001.15

TABLE 1.6
Heating and cooling equipment capacity with a change in location

London New Delhi

Capacity of cooling equipment (kW) 79.36 119.35

Capacity of heating equipment (kW) 72.95 43.32
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Step 9: Ensure that you are at the First Building level in the Navigation panel. Select the
Location tab (refer to Steps 2 and 3 of this tutorial), and click Site Details. Enter 90 in the
Site Orientation text box. Select the Layout tab. You can observe the change in the north
arrow direction before and after changing the site orientation.
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North is indicated by the direction of the north arrow in the sketch plan view. Work-
ing at the ‘untitled’ level (here First Building) of the tree means working at the site
level. For example, if there are multiple buildings on a site that are to be modelled in
DesignBuilder, after creating one building, return to the site level in the tree to start
creating the next building. Therefore, all site-specific information such as location and
orientation can be assigned to the model only when the site level is selected in the
navigation tree.

Site orientation (°) in DesignBuilder represents the alignment of the building(s) with
respect to true north. However, because there could be multiple buildings on the site,
this is called site orientation instead of building orientation.
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Step 10: Select the Simulation screen tab to get the results.

The impact of building orientation on building energy consumption is shown in the
results recorded in Table 1.7.

Changing the orientation of a building changes the heating and cooling energy consumption
as well as the size of the system. You may note that heating capacity is not affected by the
change in orientation because of the fact that the peak requirement for heating occurs in non-
sunshine hours. Hence, any orientation would require the same amount of heating (Table 1.8).

TABLE 1.7
Annual energy consumption with a change in building orientation

Type of consumption Orientation 0 degrees (kWh) Orientation 90 degrees (kWh)

Room electricity 33,167.88 33,167.88

Lighting 47,934.77 47,934.77

Heating (gas) 1,516.51 1,662.15

Cooling (electricity) 102,428.10 104,099.10

DHW (electricity) 3,001.146 3,001.146

TABLE 1.8
Heating and cooling equipment capacity with a change in building
orientation

Type of equipment Orientation 0 degrees (kW) Orientation 90 degrees (kW)

Cooling 119.35 125.60

Heating 43.32 43.32
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EXERCISE 1.3A

For New Delhi, run simulations for three more orientations: 45, 180 and 270 degrees.
Compare the results (Tables 1.9 and 1.10).

Compare the energy consumption for 0 and 180 degrees. What do you observe? It can be
seen that the results for 0 and 180 degrees are the same, and those for 90 and 270 degrees
are the same. This is due to symmetry in the shape and window distribution of the building
such that solar exposure for these two cases becomes similar. A comparison of the energy
consumption for 0 and 90 degrees shows a difference in the cooling capacity as well as
energy consumption owing to the change in solar exposure.

EXERCISE 1.3B

Change the weather locations of the model to New York and Singapore, and enter the
values in Tables 1.11 and 1.12.

TABLE 1.9
Energy consumption with a change in building orientation

Type of consumption

Annual fuel breakdown data (kWh)

0 Degrees 45 Degrees 90 Degrees 180 Degrees 270 Degrees

Room electricity

Lighting

Heating (gas)

Cooling (electricity)

DHW (electricity)

TABLE 1.10
Heating and cooling equipment capacity with a change in building orientation

Type of equipment 0 Degrees 45 Degrees 90 Degrees 180 Degrees 270 Degrees

Heating capacity (kW)

Cooling capacity (kW)

TABLE 1.11
Energy consumption with a change in building location

Type of consumption

Annual fuel breakdown data (kWh)

New York Singapore

Room electricity

Lighting

Heating (gas)

Cooling (electricity)

DHW (electricity)
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Observe and write why energy consumption and system sizing changed? It can be seen
that the extent of variation is significantly less for a change in orientation versus a change
in location. The change in energy consumption due to orientation may be more pronounced
in buildings that have a higher aspect ratio (the ratio of longer and shorter sides) because
of the change in solar exposure of the building that influences heat gain.

The change in energy consumption with location is largely due to the change in the harsh-
ness of the climatic conditions. This can be proportional to the cooling degree days (CDDs) for
cooling energy consumption and heating degree days (HDDs) for heating energy consumption.
Values for CDDs and HDDs can be found in weather files, design data books and references
such as American Society of Heating, Refrigerating and Air-Conditioning Engineers
(ASHRAE) handbooks.

HDDs and CDDs are common measures used to interpret the heating and cooling
needs of a location. Degree days are the summation of the product of the difference
in temperature (ΔΤ) between the average outdoor and the hypothetical average indoor
temperatures and the number of days the outdoor temperature is above or below the
hypothetical average indoor temperature.

The degree days are calculated in reference to a baseline line temperature that is
commonly 18°C. Temperatures above 18°C need to be cooled, and temperatures
below 18°C need to be heated.

Example: To calculate CDDs for two consecutive days:

Baseline temperature: 18 °C
Daily average outdoor dry bulb temperature (DBT) on day 1: 20°C
Daily average outdoor DBT on day 2: 17°C
CDD on day 1: 20 − 18 = 2
CDD on day 2: 17 − 18 = −1
Total CDD: 2 (sum for days that have positive values only)

The unit of measurement for CDDs and HDDs is degree days.

TABLE 1.12
Heating and cooling equipment capacity with a change in building location

Type of equipment New York (kW) Singapore (kW)

Heating

Cooling
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Tutorial 1.4

Evaluating the Impact of Opaque
Envelope Components

GOAL

To understand the impact of the thermal properties of opaque envelope components (the
external wall and roof) on HVAC system sizing and energy consumption

WHAT ARE YOU GOING TO LEARN?

• How to change wall and roof construction

PROBLEM STATEMENT

For the Courtyard with VAV Example, change the external wall from Best practice Wall,
Medium weight to Brickwork single leaf construction dense plaster, and record its impact on
the building energy performance for the London weather file.
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SOLUTION

Step 1: Open the Courtyard with VAV Example model from the template.

Step 2: Select the Construction tab.
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DesignBuilder uses a tree structure for data organization. The template is the root,
and all the other fields are the branches. DesignBuilder templates are databases of typ-
ical generic data. Therefore, when editing the template at the root level, it changes at
all branches, but if changes are made at the branch level, root and other branches will
not change.

Objects such as external walls in the Construction template can also be edited indi-
vidually without changing the complete root template. However, in this case, it is to
be noted that this particular object will be decoupled from the root. This means that
changing the root object does not impact the value of this object.

Step 3: Make sure that Best practice Wall, Medium weight is selected as External walls.

46 Building Energy Simulation



Step 4: Select the Simulation screen tab. Click on Update data. The Edit Calculation Options
screen appears. Click the Annual simulation link to set the annual simulation period.

Step 5: Record the energy simulation results.

In the following steps, you are going to change the external wall construction.

Step 6: Click the Edit screen. The Construction Template screen appears.

Step 7: Click External walls under the Construction section. Three dots (. . .) appear. Click
the three dots. The Select the construction screen appears.
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Step 8: Select Brickwork single leaf construction dense plaster.
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Step 9: Select the Simulation screen tab, and perform the annual energy simulation. View
the energy simulation results in Tables 1.13 and 1.14 and compare. It can be seen that chan-
ging the wall impacts both equipment sizing and energy consumption.

TABLE 1.13
Energy consumption with a change in external wall construction

Type of consumption

Annual fuel breakdown data (kWh)

Best practice Wall,
Medium weight

Brickwork single leaf construction
dense plaster

Room electricity 24,964 24,964

Lighting 27,059 27,059

System fans 25,418 26,119

System pumps 61 68

Auxiliary energy 21 25

Heating (gas) 37,100 80,716

Cooling (electricity) 49,136 48,741

Getting Started with Energy Simulation 49



EXERCISE 1.4

Open the model prepared in Tutorial 1.2. Assign flat roof construction as shown in
Tables 1.15 and 1.16. Simulate and compare the results for London.

You can follow similar steps for the external wall. Please refer to the following screen-
shots for help.

TABLE 1.14
Heating and cooling equipment capacity with a change in external wall
construction

Type of capacity
Best practice Wall,

Medium weight (kW)
Brickwork single leaf construction

dense plaster (kW)

Cooling 70.37 72.62

Heating 55.87 93.07

TABLE 1.16
Heating and cooling sizing with a change in roof construction

Type

Heating and cooling sizing (kW)

Roof, insulated entirely above deck,
R-24 (4.2), U-0.040 (0.23)

Uninsulated flat roof,
medium weight

Heating

Cooling

TABLE 1.15
Energy consumption with a change in roof construction

Type of consumption

Annual fuel breakdown data (kWh)

Roof, insulated entirely above deck,
R-24 (4.2), U-0.040 (0.23)

Uninsulated flat roof,
medium weight

Room electricity

Lighting

System fans

System pumps

Heating (electricity)

Heating (gas)

Cooling (electricity)
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Tutorial 1.5

Evaluating the Impact of WWR and
Glass Type

GOAL

To evaluate the impact of glazing area and glazing properties on the energy performance of
a building

WHAT YOU ARE GOING TO LEARN?

• How to creating zones in a building
• How to change the WWR
• How to change glazing type

PROBLEM STATEMENT

Create a 60- × 40-m five-zone single-story building model for London. Take WWRs of 30%
and 80% and evaluate the building energy performance. Compare cooling and heating
equipment sizing of the north and south zones. Similarly, compare sizing in east and west
zones. Evaluate the impact of glazing by changing the single-pane clear glazing (Sgl Clr
3mm) to high-performance, low solar heat gain coefficient (SHGC) dual-pane glazing (Dbl
Blue 6mm/13mm Air).

In the field of building energy simulations, glazing area is most commonly quantified
in terms of window-wall ratio (WWR). The WWR is the ratio of the total glazing area
to the total external wall area in conditioned zones.
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SOLUTION

Step 1: Open a new project, and draw a building with a size of 60 × 40 m.

Data Structure Hierarchy in DesignBuilder

Site→Building→Block→Zone→Surface→Opening

Assigning a template to the upper-level branch will result in the same template for all
the sub-branches. For example, if a construction template named ‘Framed Construc-
tion’ is assigned to the building, all floors and zones will have the same template:
‘Framed Construction’. When a particular sub-branch is edited, it is separated from
the main branch, resulting in a need for a separate edit from the main branch.

For example, if a particular zone (such as zone 1) of the first floor of the building
is selected and the construction template is changed from ‘Framed Construction’ to
‘Mass Construction’, and later the whole building is selected and the construction
template is changed from ‘Framed Construction’ to ‘Steel Construction’, the construc-
tion template of zone 1 still retains ‘Mass Construction’.

Source: https://designbuilder.co.uk/helpv6.0/#_Model_data_hierarchy_and_data_
inheritance.htm.
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Step 2: Click Block 1 in navigation tree. The display changes to Zone 1.
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Step 3: Click the Draw construction line icon to mark lines on the zone. You need to draw
an internal partition with an offset of 10 m.

Similar to other drafting programs, DesignBuilder provides some important drafting
options such as snap points, gridlines and direction snap. Make sure to select the rele-
vant options while creating the custom geometry.

Step 4: Place the pointer near the top-left corner. The pointer snaps to the corner (green
square appears at the centre of the crosshairs). Left-click once the pointer has snapped, and
then move the mouse in the right direction over the north wall of the building and type 10.
This draws a 10-m construction line from the top-left corner on the north wall.
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Step 5: Click the right end of the construction line. Now move the mouse vertically down
parallel to the west wall of the building with an offset of 10 m (as achieved in the preceding
step), and snap to the south wall (this time the crosshairs will change to the red square
because it will be edge snapping) and click.

Step 6: Continue drawing all construction lines to mark core and perimeter zones.
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Step 7: Click the Draw partition icon. The screen appears with a cursor to draw the internal
partitions.

Step 8: Trace the construction line to draw a perimeter zone on the north.
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